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Read This First 

Special Considerations 

In this manual, “Embedded Software Remote Manager” applies the word to “Remote 

Manager”. 

 

 When using a client user's PC, the client may be worried about information leaks or 

data corruption so care must be taken to reduce such fears. Before performing 

operations, it may be best to ask the client to sign a memorandum of understanding 

(such as a Non-disclosure agreement or a waiver of liability). 

 If the service representative is using their PC or a USB device to attach a client's 

PC, care should be taken to not introduce a virus or other malware into the client's 

network. 

Overview 
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 DSDK*: A DSDK application is an application developed using the Ricoh Device 

SDK, based on Java technology. 
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Installation Procedure 

Environmental Requirement 

Overview 

Remote Manager is a tool for activation and installation of DSDK applications. 

This tool contains the following features. 

 Remote installation and uninstallation of DSDK (Type J) applications 

 Remote update of DSDK (Type J) applications 

 Activation of DSDK (Type J/ Type C) applications 

 Deactivation of DSDK (Type J/ Type C) applications 

 Remote update of Java VM (Type J). 

Operation System 

 Windows 2000 SP4, Windows XP SP2 (Windows Vista is not supported) 

 Windows 2000 Server SP4 

 Windows Server 2003 SP2 

Network 

This tool can communicate to the network with the following protocols and port numbers. 

Communication with Activation Server 

 

Protocol Port numbers 

HTTPS 443 

 

Communication with devices 

 

Protocol Port numbers 

SNMP-V1 161, 162 

HTTP 8080 
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Protocol Port numbers 

HTTP / HTTPS 80/ 443 *Note 

Ricoh Discovery Protocol 51003, 51004, 51005 

 

*Note: 80: When not using SSL/ 443: When using SSL 

 

1. Make sure that SNMP-V1 is enabled. (Enable the red squared areas in the screen 

capture above) 

2. If the Community Name has been changed from the default value (public), then open 

the ClientActivator.ini file included in the Remote Manager ZIP file and change the 

Community Name as follows: 

 If the customer's Community Name is foo, the ClientActivator.ini needs to look like: 

[MFD] 

Community=foo 

 

Important! 

If the above settings are not correct, the following situation will occur: 

 Remote Manager will not be able to gather the serial number and PnP Name (model 

name) from the device. 
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Important! 

 If the device gets damaged, replaced, or discarded, you will be UNABLE to 

de-activate the product license, as the Activation Server administrator requires the 

device serial number to forcibly de-activate the license. This will make the product 

key affected to the license unusable. 

To avoid this situation, please ask the customer to keep a copy of the device’s serial 

number and the Work state archive should be created as a part of normal Remote 

Manager operation, as is shown at step 6 in page p.28 "Storing a License in a Target 

Machine". 
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Work Flow  

Installation/ Activation Flow  

DSDK Application (Type-J) Installation 

 

Preparing for installation/activation (☛☛☛☛ p.14) 

 

1. VM card installation into the device 

2. Confirm the following points. 

 Product key registration in the 

Activation Server by user. 

 Product key for activation 

 

 Check the device status using “Update 

device information” icon at each 

step.Work state archive file has to be 

saved at each step. 

Launching Remote Manager (☛☛☛☛ p.15) 

 
[DSDK Application Installation] 

 
1. Add a device (MFP) on the device list. 

 

1. Update device information (check the 

status on the device list). 

 

1. Add an application on the Remote 

Manager. 

2. Select target device on device list 

 

1. Install an application into the device (select 

target application in the window). 

2. Login to the appeared authentication menu 
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using administrator’s user name and 

password of the Web Image Monitor. 

 

1. Update device information (check the 

status on the device list). Installed 

application name should be in the 

application drop-down window. 

 
 

Activation (☛☛☛☛ p.25) 

 

 

 

DSDK Application (Type-J/C) Activation 

 

Preparing for activation (☛☛☛☛ p.14) 

 

1. VM card installation into the device 

2. Application installation into the device 

3. Confirm the following points. 

 Product key registration in the Activation 

Server by user. 

 Product key for activation 

Launching Remote Manager (☛☛☛☛ p.15) 

 

[Activation - 1st Phase] (☛☛☛☛ p.25) 

(To get the device information) 

- 
1. Add a device (MFP) on the device list. (If 

the device is on the list, it can be skipped.) 

- 
1. Select the target device on the device list 

and select an application in the window. 
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1. Update the device information. (To get the 

device information.) 

 
 

Internet connection available at a 

customer place? 
 

 
NO 

YES 

1. Save a Work state archive, and then 

change a location to get access to the 

internet connection. 

2. Get a product license and save a Work File, 

and then go to a customer place again. 

 
 

 

[Activation – 2nd Phase] (☛☛☛☛ p.26) 

(To get a license code from the Activation 

Server.) 

 
1. Add a product key in the Remote Manager. 

 

1. Get a license code from the Activation 

Server. 

 

[Activation – 3rd Phase] (☛☛☛☛ p.28) 

(To store license code into the device.) 

 

1. Store the license code into the target 

device. 

 

1. Update device information. (To get the 

device information.) 
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1. Save the device status data as a Work state 

archive file, and then ask the customer to 

keep this. 

Completed 

 

 

 

Deactivation/ Uninstallation Flow  

 

Launching Remote Manager (☛☛☛☛ p.15) 

 

1. Open the Work state archive file which is 

already saved before. 

Internet connection available at a 

customer place? 
 

 
NO 

YES  
 

[Deactivating Product] (☛☛☛☛ p.30) 

[Deactivating Product] (☛☛☛☛ p.30) 

 Deactivate License (Remove License from 

MFP). 

1. Remove the license information 

from the device at the customer 

place.  

 

 By checking ON the 

check box of "Connect to 

Activation Server" in the 

“Deactivate License” 

1. Remove the license information from the 

device at the customer place.  

 

 Check OFF the check box of 

"Connect to Activation Server" in 

the “Deactivate License” screen. 

2. Save a file as a Work state archive. 
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screen, "Login" to the 

“Activation Server” screen 

appears. 

2. Return the product license to the 

“Activation Server”. 

- 

[Changing a location to get access to the 

internet connection] (☛☛☛☛ p.30) 

 Return License (To Activation Server). 

 

1. Open the Work file, and then "Deactivate" 

with the Remote Manager.  

 

 Return the product license to the 

“Activation Server". 

2. Save a Work state archive. 

- [Going to the customer place again] 

  

Uninstalling DSDK application (☛☛☛☛ p.32) 

 

1. This uninstalls the DSDK application(s) in 

the target machines. 

Completed 

 



Installation Procedure 

14 

Installation and Activation 

Preparation before Installation 

Requirement Environment for Operation 

SNMP V1, HTTP and network connection must be required to do this installation procedure. 

 

 SNMP V1 must be enabled in target machine(s). For details about how to enable 

the "SNMP V1", see p.6 "Environmental Requirement". 

Preparation Tools and Applications 

 Remote Manager (zipped) 

 DSDK application(s) (zipped) 

Confirmation Points 

 

Confirmation Points 

 Confirm the installation possibility of multiple DSDK applications to a machine for 

your super visor or a remote support person. 

 Prepare the Product Key(s) for DSDK application(s). 

 Check and note an IP address(es) or host name(s) for a machine(s) which a DSDK 

application(s) is supposed to be installed in. 

 Check and note authentication information (user name and password of an 

administrator) of a machine(s) which a DSDK application(s) is supposed to be 

installed in. 

 Check if the VM card (Java VM) is installed in a target machine and the firmware of 

the VM card is a latest version. If not, install the VM card in a target machine and 

update the firmware to the latest one. 

 

 For updating the firmware of the VM card by using an SD card reader and 

writer, refer to RTB. 

 For updating the firmware of the VM card by using the Remote Manager via 

a network, refer to p.41 "Java VM Remote Updating". 
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Confirmation Points 

 Check if the firmware (e.g. system module) of a target machine is the latest version. 

 

Cautions about Volume License 

 In case a customer has purchased a volume license, ask the customer to manage 

the number of the available SDK application's licenses by making a list of the 

available SDK application's licenses. Remote Manager (Work status archive file) 

cannot manage the number of the available SDK application's licenses depending on 

installation circumstances and how many machines an SDK application is installed 

in.  

 

Remote Manager Launching 

 

 You must install a compatible VM card in the machine(s) before you launch the 

"Remote Manager" from an external media such as a USB memory (no installation 

required in a PC).  

 Installation must be done from a PC with a network connection to a target machine 

with the VM Card installed. 

1. Extract the "Remote Manager" zip file to an appropriate folder. 

2. Execute the "Remote Manager" utility by running (double-clicking) the 

"EmbeddedSoftwareRemoteManager.exe" file. 

3. The main menu screen of the "Remote Manager" appears. 

 

 This application can be launched directly from an external media such as a 

USB memory (no installation required in a PC). 

Installation and Activation Icons  
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There are seven icons at the upper-left on the toolbar of the Remote Manager. These icons 

provide easy and quick ways of the installation and activation for the SDK application. Each 

icon's function is described in the icon list below; 

 

Icon Description 

 
Adds a device (MFP) on the device list. 

 
Updates device information (checks the status on the device list). 

 
Adds an SDK application on the Remote Manager. 

 

Installs an SDK application into the target device (selects the target application in 

the window). 

 
Adds a product key in the Remote Manager. 

 
Gets a license code from the Activation Server. 

 
Stores the license code into the target device. 

 

Status Icon List 
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The status icons shown at the first column in the device list indicate current status of the 

target machines. 

 

Icon Description 

None Application is not installed. 

 No information is available. 

 Application is installed. 

 Application is installed and license is obtained from the Activation Server. 

 Application is installed and license is stored in the target machine. 

 Error Status 

 

License is removed from a machine, but is not returned to the activation server 

yet. 

 

DSDK Application Installation 

Registering a Target Machine in the Remote Manager 

1. Open the "Remote Manager". 

 

2. The main menu screen of the "Remote Manager" appears. 

 

 Make sure that the PC running the "Remote Manager" must be able to connect 
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to the target machine via network. 

 Check the status of the target machine(s). 

 

 If a previous setting still appears on the screen, open the "File" and select "New" to 

refresh the screen. 

 

3. Click the "Device List" icon on the left window to ensure you are working on a Device 

List (it is highlighted). 
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4. Open the "Operation" menu item and click the "Add" > "Manual Input…". 

 

 You can register machines with "From File." at this point. For details, see the 

p.46 "Add From File" in the Appendix section. 

 

5. Enter the IP address or host name of the target machine and give a display name to the 

target machine (Description). For segment numbers less than 100, do not include a “0” 

before the number, as an error will occur. 

 

 The display name is the name shown in the "Device List" window of this utility. 

 You can register multiple machines to the "Device List" with this manual input. 

6. Check the check box [A], and then click the "OK" button. 

 

 You can get information of registered machines from the property menu once 

you have registered the target machines with the check box [A] filled. 

 

7. The IP address or host name and description of the target machine appear in the 

"Device List" window. 
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8. Check if the SDK application to be installed supports this version of the Java VM. 

 Device List > Operation > Property  

 Device List > right-clicking in the device list > Property 

Adding a DSDK Application in the "Remote Manager" 

 

1. Click the "Software" icon in the left window to work on Software (it is highlighted). 

 

2. Select the "Operation" menu item and click the "Add…". 
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3. Select a DSDK application zip (product-ID zip) previously downloaded and click "Open" 

button. 

 

4. The software name and version now appear in the "Software List" window of this utility. 

Installing the DSDK Application in the Target Machine 

 

1. Click the "Device List" icon on the left window to ensure you are working on a Device 

List (it is highlighted). 
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2. Click the display name of the target machine on the "Device List" window to install the 

DSDK application (it is highlighted). 

 

 You can select multiple target machines here with the display names 

highlighted. 

 

3. Select the "Operation" menu item and click the "Install…". 

 

4. Select the software to be installed and the slot in the drop-down window where the VM 

card has already been installed.  

 

 For some DSDK applications, selecting the slot is not required (drop-down 

window is grey down). 

5. Click on the "OK" button. 
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6. Ask a machine administrator to input a user name and password of the machine 

administrator.  

7. Click the "OK" button. 

 

8. Click the "OK" button after the installation completion screen has appeared. 

 

9. Select the target machine to view in the Device List. 

10. Select the "View" menu item and click the "Refresh. 

 

 Click the "Refresh All" if you have installed software in the multiple target 
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machines. This refreshes all machines listed in the "Device List". 

 

11. Click the device in the window (it is highlighted). 

12. Select the DSDK Application which is already installed from the “Application” drop-down 

window.  

 

 In this example, “GlobalScan NX” is selected. 

 

13. The white lamp icon indicates that the DSDK application is appropriately installed. Make 

sure that the lock code appears in the Lock Code column. 

 

 There are some status icons shown at the left of the "Address" column in the 

"Device List". See p.16 "Status Icon List" in this chapter. 

 

14. Check if the version of the installed SDK application matches the version of the 
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customer's SDK application in the client PC by opening the device property screen. 

 Device List > Operation > Property  

 Device List > right-clicking in the device list > Property 

Product Activation 

Confirmation Points   

To activate DSDK Application, the followings are required: 

 Product Key(s) for DSDK application(s) 

 User name and password for login to the activation server  

 Check the status of the target machine(s). 

Ask a customer about the user name and password and Product Key(s) which the customer 

has already registered in the activation server. 

Adding a Product Key for DSDK Application in the Remote Manager 

 

1. Click the "Product Key" icon on the left window to ensure you are working on a Product 

Key list.  

2. Select the DSDK application you want to activate (it is highlighted). 

 

3. Select the "Operation" menu item and click on the "Add". 
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 Product keys can be also added by "Import…" from a file. For details, see p.47 

"Importing Product Keys from File" in the Appendix section. 

 

4. Enter the exact same "Product Key" provided with a product certification which a 

customer has received after purchasing DSDK Application. 

 

 You can also register multiple product keys in the "Product Key List" one by one 

with this product key entry. 

 

5. A "Product Key" appears in the "Product Key list" window. 

 

 The "Total Licenses" varies depending on a condition of product purchase. 

 The available licenses are automatically used from the top line in the product 

key column. It is not possible to decide which product key is used.  

Getting a License for DSDK Application from Activation Server 

 

 To get a license for DSDK Application, the internet connection is required. If it is not 

available, see p.46 "Getting and Returning a License without Internet Connection" 

in the Appendix section for details. 
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1. Click the "Device List" icon on the left window to ensure you are working on a "Device 

List" (it is highlighted). 

2. Click the device in the "Device List" window (it is highlighted). 

3. Select the DSDK Application which is already installed from the "Application" drop-down 

window.  

 

 In this example, “GlobalScan NX” is selected. 

 

4. Select the "Operation" menu item and click the "Get License". 

 

5. Enter the exact same "User ID and Password" registered in the activation server. 

 

 The "User ID and Password" have a word limitation. For details, refer to "xxx" in 

the Appendix section. 

6. Select the "OK" button. 
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 "Register User" button is used only when a customer has not registered user 

information to the activation server. For details, see p.47 "Product Registration 

for DSDK Application" in the Appendix section. 

 

7. Click the "OK" button after the completion screen of the license publication has 

appeared. 

Storing a License in a Target Machine 

 

1. The picture above shows the followings: 

 The DSDK application has been installed in the target machine.  

 The product license for the selected DSDK application has already been obtained 

from the activation server. 

2. Select the "Operation" menu item and click the "Store License…" to store the product 

license in the target machine. 
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3. The "Store License" process runs and displays a notification box when it is completed. 

4. Click the "OK" button. 

 

5. Make sure that the blue icon appears in the "Device list" when the DSDK Application is 

appropriately activated (license for the selected application has already been stored in 

the target machine). 

 

 If any other icon except blue appears in the "Device list", check the icon 

appeared in the "Device List". And then retry this procedure. 

6. Save this device status data as a Work state archive (filename.caz) after storing a 

license in a target machine and ask a customer to keep this file. 

 

 This Work state archive will be necessary for the deactivation and uninstallation 

of DSDK application(s). Make sure that a customer keeps a Work state archive. 

7. Select the "File" menu item, and then "Exit" to close the "Remote Manager". 

 

 Clicking the close application window button ([X] in upper right) can also close 

the "Remote Manager". 

8. The pop-up dialogue box appears to ask you again if this device status data has to be 

saved to a Work state archive (filename.caz).  

9. Select the "Yes" button if you have not saved the device status data (Work state 

archive). 

10. Ask a machine administrator to check if the activated DSDK application is "Starting Up". 
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Uninstallation Procedure 

Deactivation and Uninstallation 

Deactivation 

You can deactivate DSDK Application in a machine installed before, and then activate it in 

another machine.  

Returning a License for DSDK Application to the Activation Server 

 

 To return a license to the activation server, the internet connection is required. If it is 

not available, see p.46 "Getting and Returning a License without Internet 

Connection" in the Appendix section. 

1. Execute the "Remote Manager". 

2. Open the Work state archive (filename.caz) which is already saved before. 

 

3. Click the "Device List" icon on the left window to ensure you are working on a Device 

list. 

4. Select the DSDK Application you want to deactivate (it is highlighted). 

 

5. Select the "Operation" menu item and click the "Deactivate". 
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6. If a machine and "Remote Manager" are in internet connection, click the check box to 

connect to the activation server. 

If not, continue this procedure without clicking the check box. 

7. Click the "OK" button. 

 

8. Click the "OK" button after the "Deactivate" from the target machine has been 

completed. 

9. SAVE this deactivation data from the target machine as a Work state archive file if the 

machine and "Remote Manager" are not in the internet connection or you quit this 

deactivation procedure now. 

 

 This deactivation data must be necessary for deactivating the license from the 

activation server later. 

 

10. Enter the exact same "User ID and Password" registered in the activation server. 
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 The "User ID and Password" have a word limitation. For details, refer to "xxx" in 

the Appendix section. 

11. Click the "OK" button. 

 

12. Click the "OK" button after "Deactivate" from the activation server has been completed. 

 

13. The white lamp icon appears in the Device list if the DSDK Application is appropriately 

deactivated.  

14. Go to step 2 in the "DSDK Application Uninstallation" to continue the deactivation and 

uninstalltion procedure. 

15. If you want to quit here before the uninstallation procedure, save this device status data 

as a Work state archive (filename.caz) and ask a customer to keep this file. 

 

 This Work state archive (filename.caz) will be necessary for the uninstallation 

of DSDK application(s). 

DSDK Application Uninstallation 

 

 Unistallation must be executed from a PC with a network connection to a target 

machine. 

 Before this uninstallation procedure, deactivation must be done. Otherwise, product 

key will be wasted. 

1. Execute the "Remote Manager" and open the Work state archive (filename.caz) which 

is already saved before if you have closed the "Remote Manager" after the deactivation 
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procedure. 

 

2. Click a target machine to uninstall DSDK Application in a Device List on the right 

window (it is highlighted). 

 

3. Select the "Operation" menu item and click "Uninstall". 

 

4. Select software to uninstall and click the “OK” button. 
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5. Ask a machine administrator to input a user name and password of the machine 

administrator.  

6. Click the "OK" button.  

 

7. Click the "OK" button after the uninstallation completion screen has appeared. 

 

8. Select the target machine to view in the Device List. 

9. Select the "View" menu item and click the "Refresh. 

 

 Click the "Refresh All" if you have installed software in the multiple target 

machines. This refreshes all machines listed in the "Device List". 
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10. Select the "File" menu item, and then "Exit" to close the "Remote Manager". 

 

 Clicking the close application window button ([X] in upper right) can also close 

the "Remote Manager". 

11. The pop-up dialogue box appears to ask you if this device status data has to be saved 

to a Work state archive (filename.caz).  

12. Select the "Yes" button if you have not saved the device status data (Work state 

archive). 

13. Ask a customer to keep this Work state archive (filename.caz). 
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Remote Updating 

DSDK Remote Updating  

 

 First update the DSDK/J Platform if the DSDK/J Platform and DSDK application 

are supposed to be updated at the same time. 

Remote Manager can update a DSDK application in the target machine. To update a DSDK 

application with the Remote Manager, follow the procedure below. 

1. Ask a machine administrator to stop the DSDK application with the operation panel (the 

procedure for stopping a DSDK application is described below for reference). 

 

 Stop other SDK applications if they have been installed in the machine. 

 You can also stop the DSDK application with the web image monitor (the 

procedure for stopping a DSDK application is described below for reference). 

2. Launch the Remote Manager. 

3. Add a DSDK application for updating in the Remote Manager (see p.20 "Adding a 

DSDK Application in the "Remote Manager""). 

4. Install the DSDK application for updating in the target machine (see p.21 "Installing the 

DSDK Application in the Target Machine"). 

5. Turn off and on the target machine. 

6. Ask a machine administrator to check if the version of the DSDK application is updated 

and if the installed DSDK application is "Starting Up". 

To stop a DSDK application with Operation Panel 

1. Press User Tools/Counter key on the machine's operation panel. 

2. Log in the "User Tools" using a machine administrator account (user name and 

password). 
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3. The screen shown above is displayed. 

4. Press "Extended Features Settings". 

 

5. The screen shown above is displayed. 

6. Press "Extended Features Settings". 

 

7. Press a bar of the target DSDK application to stop. 
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8. "Stop" is displayed in the Status column and DSDK application bar turns white if a target 

DSDK application is stopped. 

To stop a DSDK application with Web Image Monitor 

 

1. Access the "Web Image Monitor" of the target machine using your web browser. 

2. Click the "Login" button. 
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3. Login the target machine using a machine administrator name and password. 

 

4. Click the "Configuration". 
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5. Click the "Startup Setting" in the "Extended Feature Settings". 

 

6. Check the radio button of a DSDK application to be updated, and then click the "Start 

Up/Stop". 

 

7. "Stop" is displayed in the Status column if a target DSDK application is stopped. 
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Java VM Remote Updating 

 

 First update the DSDK/J Platform if the DSDK/J Platform and DSDK application 

are supposed to be updated at the same time. 

Remote Manager can update a DSDK/J Platform in the target machine. To update a DSDK/J 

Platform with the Remote Manager, follow the procedure below. 

1. Ask a machine administrator to stop the DSDK application with the operation panel (the 

procedure for stopping a DSDK application is described below for reference). 

 

 Stop other DSDK applications if they have been installed in the machine. 

 You can also stop the DSDK application with the web image monitor (the 

procedure for stopping a DSDK application is described below for reference). 

2. Launch the Remote Manager. 

3. Add a DSDK/J Platform for updating in the Remote Manager (see p.20 "Adding a DSDK 

Application in the "Remote Manager""). 

4. Install the DSDK/J Platform for updating in the target machine (see p.21 "Installing the 

DSDK Application in the Target Machine"). 

5. Turn off and on the target machine. 

6. Ask a machine administrator to check if the version of the DSDK/J Platform is updated 

and if the installed DSDK/J Platform is "Starting up". 
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Appendix 

Appendix 

Operation Screen 

Device List: Column Description and Menu Description 

 

Up to 100 devices can be registered in the Device List. 

 

Column Name Decription 

Address Displays IP address(es) or host(s) name of added target machines. 

Description Displays description(s) of the target machines. 

# of … Displays the number of installed applications in the target machine. 

Product Key Displays a product key added for the target machine. 

Lock Code Displays the lock code of the target machine. 

License Code 

(not shown) 

Displays "Exists" if a product license is added to the target machine.

Displays "Removed" if a product license is returned from the target 

machine. 

Status  

(not shown) 

Displays the result (message and error code) of the latest operation 

for the target machine. For details about error code, see the 

"Troubleshooting" following this content. 
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Menu Item Description 

Add – Manual Input… Adds a machine (device) manually. 

Add – From File… Adds a machine from a CSV file or hosts file. 

Delete Deletes a machine in the device list. 

Properties… Opens a machine's information screen. 

Export… Exports a device list as a CSV file format. 

Install… Installs or updates a DSDK application in the target machine.

Uninstall… Uninstalls a DSDK application from the target machine. 

Get License… Gets a product license for the target machine. 

Recover License… Not supported. 

Store License… Stores an obtained product license in the target machine. 

Deactivate… Deactivates the product license in the target machine. 

 

Product Key: Column Description and Menu Description 
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Column Description 

Product Key Product key 

Total License The number of licenses included in the product key 

Unused License The number of licenses not yet assigned 

 

 

 

Menu item Description 

Add… Adds a product key to the list 

Delete Deletes the product keys selected from the list  

Import… Imports product keys from the product key list files. 

Export… Exports the product key list to one or more files. 

 

Software: Column Description and Menu Description 
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Up to 64 software can be registered in the Software list. 

 

Column Description 

Name Software name 

Version Software version 

Type 

Software type  

There are the following software types: 

 Application: Application (New install) 

 Application update: Application (Update install) 

 DSDK/J Platform update: DSDK/J Platform (Update install) 

 

 

 

Menu item Description 

Add… Adds new software to the list  

Delete Removes the software selected from the list  

Property… Shows the properties of the software selected from the list 
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Getting and Returning a License without Internet Connection 

To get or return a license for DSDK Application, the internet connection is required. If it is not 

available, follow the procedure below; 

1. Open the Work state archive (filename.caz) which is already saved before. 

2. Get or return a license in anyplace where you can access the internet with the "Remote 

Manager".  

3. Save a Work state archive (filename.caz).  

 File > Save or Save as 

Add From File 

You can add devices from a CSV file (Remote Manager format) or a hosts file exported from 

the "SmartDeviceMonitor for Admin". 

 

The dialogue above is displayed when "From File" menu is selected (Operation > Add > 

From File). 

Menu List 

 

Menu item Description 

File 
Path of CSV file or hosts file 

Maximum character strings: 260 

Retrieve installed application 

information 

When check box is checked, device information is 

updated after pressing [OK]. 
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Importing Product Keys from File 

 

Product keys can also be added by importing from a file (Operation > Import…). The file that 

can be imported is text file with one line per product key as shown below. 

 

 

 Each product key must be typed in each line in a ".text" formatted file. Otherwise, 

importing product keys from a file may fail. 

Product Registration for DSDK Application 

If you are asked to register a user name and password and product key(s) by a customer, 

follow this procedure.  

1. Access the following URL. 

 URL: https://www.onlineactivation.net/marketplace 

2. Select the language to display from the drop-down list. 
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3. Under “New Customer”, click [Click here]. 

 

4. Enter all required information (arrow marks indicate a required field). 

 

 After entering User ID and Password of customer's choice, instruct a customer 

to keep the information in a safe place. This information must be necessary for 

changing the registration information in the future. 

5. Click [Next]. 
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6. Click [OK] after the Data Confirmation message has appeared.  

 

7. Fill in all fields, and then click [Next]. 

8. The Data Confirmation message appears. Click [OK]. 

9. The Product Key and User information are successfully registered. 
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10. Click [Close]. 

Work State Archive Description 

Device list, product key list and software list can be saved in a Work state archive. All the 

Work state archives are archived in zip but with the extension caz. 

Device list 

The format is the same as those created by Remote Manager. File name is Devicelist.csv. 

Product key list 

One file is created per a feature as [Feature name].txt. Each file contains its product keys, 

with one line per product key.  

Software list 

All the contents in the software list window are saved into SoftwareList.csv. 

Reading files 

Retrieve each file from a caz file and update all the lists. 

Saving files  
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Save all the Work state archives into a .caz file (archived in zip). 

Device List File Description 

The following is the configuration of the Device List File (CSV file) exported by Remote 

Manager. The first line should describe the following: 

CSV file configuration  

 

Column Value Comments 

1 Device Address  

2 Device Description  

3 Product ID  

4 Feature Name  

5 Product Key  

6 Software Name  

7 Lock Code  

8 License Code  

9 Status Code  

10 Device Serial Number  

11 Model Name (PnP Name)  

12 Java VM Version  

13 Activation Status 

Following values are input in this field  

 none: Not activated 

 Invalid: Activation is invalid 

 et: License is obtained from Activation 

Server 

 cancel: License code is deactivated 

 success: Activated successfully 
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Column Value Comments 

14 Application Version  

15 Uninstall is possible 

Whether if uninstall is possible or not 

 enable: possible  

 disable: impossible 

16 Device error code 
Error code obtained from device (decimal 

number) 

 

Troubleshooting 

Error Messages 

 

Error Message Comment 

An unknown error occurred. 
This uncommon error typically indicates an 

unstable system. Reboot or use a different PC.  

Reading file failed. 

Remote Manager was not able to read the selected 

file. Please verify that the file is the correct format 

and exists at the target location. 

Writing file failed. 

Remote Manager was not able to write the file.  

Please check the available space and access 

privileges for the target location.   

Initialization failed. 
Remote Manager was unable to initialize its file 

library.  Reboot or use a different PC. 

An internal processing error 

occurred. 

An invalid value was encountered. This is a critical 

error, and the log file should be sent to RCL. 

A timeout error occurred. Check the network environment. 

There is insufficient memory. Add more virtual memory. 

File compression failed. Unable to compress file due to lack of disk space or 
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Error Message Comment 

system error. Verify the available disk space and try 

again. 

File decompression failed. 

Remote Manager was unable to decompress the 

targeted file. Verify that the file is not corrupt, and 

that there is enough space on the disk for a 

temporary file. 

There has been a sharing violation.
The target device maybe in use. Please try again 

later. 

You do not have access privileges 

for this operation. 

The current user does not have access privileges.  

Please log in as an administrator. 

The process could not be 

completed because the disk is full. 

There is not enough space on the HDD to save the 

temporary files. Create some free space before 

retrying. 

A network communication error 

occurred. 
Check the network environment. 

Authentication failed. 
The entered username/password is incorrect.  

Please verify the login information. 

File name has not been specified. A target file has not been selected. 

The target device does not exist. 

The targeted device(s) have already performed the 

selected operation. Please choose a different 

device. 

The specified file could not be 

opened. 
The targeted file is in the wrong format. 

The device is not yet ready. 
Device is on but unable to receive information (i.e. 

device is warming up). Wait for a while then retry. 

The process could not be 

completed because the device is in 

use. 

Wait for the device to become available then retry. 
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Error Message Comment 

The specified device is turned off or 

is not supported. 

Make sure the selected device is a supported type 

and is turned on. 

Enter the address of the device. 
No IP address was entered.  Please enter an IP 

address then retry. 

The specified device is already 

added. 

The device is currently registered. Please specify a 

different device. 

There are not enough licenses 

available. 

All licenses of a registered product key are in use. 

Add a different product key, or deactivate an active 

device.  

Failed to make a request for license 

publication to Activation Server. 

The local network environment has a problem, or 

the Activation Server is down. 

Failed to obtain license code. 

The local network environment has a problem, or 

the Activation Server has detected an error or 

timed out. 

Device information could not be 

updated. 
There was a network error. Please try again later. 

The product key entered is invalid. 
The product key is incorrect. Please verify and try 

again. 

The product key entered does not 

match with the application selected.

The product key was correct but for a different 

application.  Please select the correct application 

or a different product key. 

The product key entered is already 

added. 

Please verify that the correct key was input, or 

enter a different product key. 

The product key specified cannot 

be deleted because it is being 

used. 

Please deactivate all licenses before attempting to 

delete the key. 

The product key has not been 

added. 

The current operation was unable to complete 

because no corresponding product key has been 
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Error Message Comment 

registered.  Please add a product key to complete 

the operation. 

There are not enough product keys. 

Please add more license(s). Do you 

want to continue anyway? 

There are not enough licenses available to activate 

on all selected machines.  Please add more 

licenses/product keys, or deactivate any undesired 

devices. 

The software specified is invalid. 

The selected package contains unsupported 

software.  Please select a different package, or 

verify the contents of the desired package. 

The software specified is already 

added. 
The selected application is currently registered. 

Some of the devices could not be 

imported because the maximum 

number of devices has been 

reached. Check the results of the 

operation. 

 Remote Manager was unable to import all 

devices from a Work state archive, a CSV file, 

or a Hosts file as the maximum number of 

registered devices has been reached. 

Determine which devices were added, then 

manually add/remove as desired. 

Some of the software could not be 

imported because the maximum 

number of software has been 

reached. Check the results of the 

operation. 

 Remote Manager was unable to import all 

applications from a Work state archive as the 

maximum number of registered applications 

has been reached. Determine which 

applications were added, then manually 

add/remove as desired. 

There is some invalid device 

information in the file. Check the 

results of the operation. 

 The selected Work state archive, hosts file or 

CSV file contains invalid device information. 

Please verify that all device information in the 

selected file is correct. 

There are some invalid product 

keys in the file. Check the results of 

the operation. 

 The selected Work state archive or text file 

contains an invalid product key. Please verify 

that all product keys in the selected file are 
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Error Message Comment 

correct. 

There is some invalid software in 

the file. Check the results of the 

operation. 

 The selected Work state archive contains 

invalid application data. Please verify that all 

application data in the selected file is correct. 

The software selected does not 

exist. 

Remote Manager was unable to detect the 

selected application for uninstallation. Please verify 

that the application is currently installed on the 

device. 

Software is not selected. 
No application was chosen.  Please be sure to 

chose an application for removal. 

Necessary modules are not found. 

Necessary components of the application package 

are missing. Please contact RCL for a new 

application package. 

 

Error Code 

Error code is displayed in the "Status" column of Remote Manager’s operation screen. 

If an error still appears after taking action, collect all of Remote Manager’s logs that are 

saved in the folder (default folder name: temp) where 

EmbeddedSoftwareRemoteManager.exe is located so that they may be used for analysis. 

(See p.70 "Collection of Remote Manager's Logs ") 

 

Error Code Description 

ERROR: Operation progress could not be obtained. 

E00 

<Action>: 

Try again later. 

<Remarks>: 

This is a rare case. This might occur when sending a license request 

to the Activation Server immediately after registering the product key 

on the Activation Server. 
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Error Code Description 

ERROR: Authentication failed. 

E01 
<Action>:  

Verify that the User ID and Password are correct then try again. 

ERROR: The product key is invalid. 

E02 <Action>:  

Verify that the product key is correct and is registered with the 

Activation Server. 

ERROR: The product name is invalid. 

E03 
<Action>:  

Contact the administrator of the Activation Server because this error 

is caused by a mistake made when the product was added to the 

Activation Server. 

ERROR: The lock code is invalid. 

E04 <Action>:  

Reboot the device. If the error still appears, the device in question is 

the source of the trouble. 

ERROR: [Get/Reissue License] Database write error 

E05 

<Action>:  

Contact the administrator of the Activation Server. 

<Remarks>:  

This is a rare case and caused by an internal error on the Activation 

Server. The license was issued by the Activation Server but failed to 

be written to the Activation Server’s DB. 

E06 
ERROR: [Get License] A license has already been issued by the 

Activation Server. 
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Error Code Description 

<Action>:  

Save the current status in a work state archive, and then restart 

Remote Manager.  

<Remarks>:  

This is a rare case and caused by an internal error in Remote 

Manager. 

ERROR: [Reissue License] A license has not been issued by the 

Activation Server. 

E07 

<Action>:  

Save the current status in a work state archive, and then restart 

Remote Manager. 

<Remarks>:  

This is a rare case and caused by an internal error in Remote 

Manager. 

ERROR: [Get/Reissue License] The license has expired. 

E08 <Action>:  

Contact the administrator of Activation Server because at this time 

there is no product with a limited-time license. 

ERROR: [Get/Reissue License] The Activation Server failed to 

generate a license code. 

E12 
<Action>:  

Contact the administrator of the Activation Server because this error 

is caused by an internal error on the Activation Server. 

ERROR: Failed to read product key file. 

E13 <Action>:  

Contact the administrator of the Activation Server because this error 

is caused by an internal error on the Activation Server. 

E14 ERROR: Failed to read lock code. 
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Error Code Description 

<Action>:  

Contact the administrator of the Activation Server because this error 

is caused by an internal error on the Activation Server. 

ERROR: Failed to read license code file. 

E15 <Action>:  

Contact the administrator of the Activation Server because this error 

is caused by an internal error on the Activation Server. 

ERROR: The maximum number of devices allowed for batch 

registration has been exceeded. 

E16 
<Action>:  

Save the current status in a work state archive, and then restart 

Remote Manager. 

<Remarks>:  

This is caused by an internal error in Remote Manager. 

ERROR: Product key information does not match. 

E17 

<Action>:  

Save the current status in a work state archive, and then restart 

Remote Manager. 

<Remarks>:  

This is caused by an internal error in Remote Manager. 

ERROR: Failed to delete uploaded files. 

E18 <Action>:  

Contact the administrator of the Activation Server because this error 

is caused by an internal error on the Activation Server. 

E19 ERROR: License data was not found. 
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Error Code Description 

<Action>:  

Save the current status in a work state archive, and then restart 

Remote Manager. 

<Remarks>:  

This is caused by an internal error in Remote Manager. 

ERROR: POST data could not be received. 

E20 <Action>:  

Contact the administrator of the Activation Server because this error 

is caused by an internal error on the Activation Server. 

ERROR: USERID is invalid. 
E21 

<Action>: Input a valid user ID. 

ERROR: PASSWORD is invalid. 
E22 

<Action>: Input a valid password. 

ERROR: PROCESSNAME is invalid. 

E23 

<Action>:  

Save the current status in a work state archive, and then restart 

Remote Manager. 

<Remarks>:  

This is caused by an internal error in Remote Manager. 

ERROR: PROCESSFLG is invalid. 

E24 

<Action>:  

Save the current status in a work state archive, and then restart 

Remote Manager. 

<Remarks>:  

This is caused by an internal error in Remote Manager. 

E25 ERROR: PRODUCTNAME is invalid. 
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Error Code Description 

<Action>:  

Save the current status in a work state archive, and then restart 

Remote Manager. 

<Remarks>:  

This is caused by an internal error in Remote Manager. 

ERROR: [Reissue License] License reissuing is not supported for 

this application. 

E26 <Action>:  

Contact the administrator of the Activation Server to determine if the 

current license is capable of being forcibly deactivated (allowing for 

a new license to be issued). 

ERROR: Failed to access database. 

E30 <Action>:  

Contact the administrator of the Activation Server because this error 

is caused by an internal error on the Activation Server. 

ERROR: The product key has not been registered with the 

Activation Server by the specified user. 

E41 
<Action>:  

The current product key is not registered with the currently logged in 

user. Register the product key with the Activation Server. 

ERROR: [Deactivate (Activation Server)] No record of the License 

exists in the Activation Server. 

E43 
<Action>:  

Save the current status in a work state archive, and then restart 

Remote Manager. 

<Remarks>:  

This is caused by an internal error in Remote Manager. 

E44 
ERROR: [Deactivate (Activation Server)] This product key has been 

activated too many times and may not be deactivated. 
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Error Code Description 

<Action>: Use another product key to activate the product, or 

contact the administrator of the Activation server if you feel you have 

received this message in error. 

ERROR: [Deactivate (Activation Server)] The maximum number of 

licenses for use in a batch operation has been exceeded. 

E45 
<Action>:  

Save the current status in a work state archive, and then restart 

Remote Manager. 

<Remarks>:  

This is caused by an internal error in Remote Manager. 

ERROR: [Store License] An error occurred during data transmission.

E51 <Action>: 

- Remote Manager might have failed to write the output file. Check 

the available space and access privileges for the target media. 

ERROR: Could not obtain information about the installed 

applications. 

E52 

<Action>: 

- Check that the device is turned on and that the device is connected 

to the network. 

- Check if the IP address or the host name of the device is correct. 

- Make sure that a VM card is attached to the device and that Java 

VM is started up. 

ERROR: [Store License] There was a network communication error.

E54 
<Action>: 

If using a host name, verify that the host name is correct. If the host 

name is correct, check the network environment and the network 

settings of the device. 

ERROR: [Store License] Device preprocessing failed. 
E55 

<Action>: Restart the device. 
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Error Code Description 

ERROR: [Store License] Application information could not be 

obtained. 
E56 

<Action>:  

Verify that the application is installed on the device. 

ERROR: [Store License] There was a communication error with the 

device. 

E57 
<Action>:  

Check the network environment and the network settings of the 

device. 

ERROR: [Store License] The target application was not found. 

E58 
<Action>:  

Make sure that the application is installed on the device. 

ERROR: [Deactivate (Devices)] 

E70 

<Action>: 

- Remote Manager might have failed to write the output file. Check 

the available space and access privileges for the target media. 

- Remote Manager might have failed to stop the application. Retry 

after stopping the application. 

ERROR: [Deactivate (Devices)] There was a network 

communication error. 

E72 <Action>: 

If using a host name, verify that the host name is correct. If the host 

name is correct, check the network environment and the network 

settings of the device. 

ERROR: [Deactivate (Devices)] Device preprocessing failed. 
E73 

<Action>: Restart the device. 

E74 
ERROR: [Deactivate (Devices)] Failed to get application 

information. 
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Error Code Description 

<Action>:  

Make sure that the application is installed on the device. 

ERROR: [Deactivate (Devices)] There was a device communication 

error. 

E75 
<Action>:  

Check the network environment and the network settings of the 

device. 

ERROR: [Deactivate (Devices)] The target application was not 

found. 

E76 
<Action>:  

The Java VM Platform might not be operating correctly. Restart the 

device. 

ERROR: [Deactivate (Activation Server)] A license was not issued 

for the selected product key. 
E77 

<Remarks>:  

The license may have been deactivated already. 

An unknown error occurred. 

E99 

<Action>:  

Save the current status in a work state archive, and then restart 

Remote Manager. 

<Remarks>:  

This is a rare case and is caused by an internal error in Remote 

Manager. 

ERROR: [Installation] Could not communicate with devices. 

E100 <Action>: 

Check the network environment and the network settings of the 

device. 

E101 ERROR: [Installation] There was an internal processing error. 
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Error Code Description 

<Action>:  

Save the current status in a work state archive, and then restart 

Remote Manager. 

<Remarks>:  

This is a rare case and is caused by an internal error in Remote 

Manager. 

ERROR: [Installation] There was a memory error. 

E102 

<Action>:  

Increase the size of the Heap memory or stop the active application. 

(See p.77 "Procedure for Changing a Device's Heap and Stack 

Sizes")  

<Remarks>:  

The available Heap memory is insufficient. If the file size of an 

application is large, memory is used when installing an application. 

ERROR: [Installation] An I/O error occurred on the device. 

E103 <Action>:  

Remote Manager may have failed to write the file. Check the 

available space and access privileges for the target media. 

ERROR: [Installation] A network error occurred on the device. 

E104 <Action>:  

The Java VM Platform might not be operating correctly. Restart the 

device. 

ERROR: [Installation] A communication error occurred on the 

device. 

E105 
<Action>:  

The Java VM Platform might not be operating correctly. Restart the 

device. 

E106 ERROR: [Installation] The application failed to install. 
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Error Code Description 

<Action>:  

The Java VM Platform might not be operating correctly. Restart the 

device. 

ERROR: [Installation] The jar files are invalid. 

E107 

<Action>:  

Contact the application design section. If the application is released 

from Japan, contact the Service Support Department of Ricoh 

Japan. 

<Remarks>:  

The software package was incorrectly prepared. 

ERROR: [Installation] The device's serial number is invalid. 

E108 

<Action>:  

Select the correct device for the chosen serial number, or verify that 

the serial number is correct for the selected device. 

<Remarks>:  

This error appears if the application’s license is limited to a specified 

device. 

ERROR: [Installation] An internal file transfer error occurred on the 

device. 

E109 <Action>:  

Remote Manager might have failed to save a file on the target 

device when updating Java VM. Check the available space and 

access privileges for the target media. 

ERROR: [Installation] A zip file handling error occurred on the 

device. 

E110 
<Action>:  

The uploaded file might not be a zip file. Verify that the uploaded file 

is a zip file. 
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Error Code Description 

ERROR: [Installation] Zip file decompression error occurred on the 

device.  
E111 

<Action>:  

The zip file might be damaged or corrupted. Obtain another zip file. 

ERROR: [Installation] An unknown error occurred on the device. 

E112 <Action>:  

The Java VM Platform might not be operating correctly.  

Restart the device. 

ERROR: [Uninstallation] Could not communicate with the device. 

E200 <Action>:  

Check the network environment and the network settings of the 

device. 

ERROR: [Uninstallation] There was an internal processing error. 

E201 

<Action>:  

Save the current status in a work state archive, and then restart 

Remote Manager. 

<Remarks>:  

This is a rare case and caused by an internal error in Remote 

Manager. 

ERROR: [Uninstallation] A memory error occurred on the device. 

E202 

<Action>:  

Increase the size of the Heap memory or stop the active application.

<Remarks>:  

The available Heap memory is insufficient. If the file size of an 

application is large, memory is used when installing an application. 

E204 ERROR: [Uninstallation] A network error occurred on the device. 
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Error Code Description 

<Action>:  

The Java VM Platform might not be operating correctly.  

Restart the device. 

ERROR: [Uninstallation] A communication error occurred on the 

device. 

E205 
<Action>:  

The Java VM Platform might not be operation correctly.  

Restart the device. 

ERROR: [Uninstallation] The application failed to uninstall. 

E206 

<Action>:  

The application may have been uninstalled already. 

If the application is not uninstalled, uninstall the application from the 

device using its operation panel or Web Image Monitor. If 

uninstallation still fails, the registration information or an application 

file is probably damaged. In this case, replace the VM card. 

ERROR: [Uninstallation] An unknown error occurred on the device. 

E212 <Action>:  

The Java VM Platform might not be operating correctly.  

Restart the device. 

 

Troubleshooting for Installation/ Activation/ Deactivation/ Uninstallation  

Remote Manager Installation/ Activation/ Deactivation/ Uninstallation Procedure: 

<Installation/Activation>: 

1. Registering a Target Machine in the Remote Manager 

2. Adding a DSDK Application in the Remote Manager 

3. Installing the DSDK Application in the Target Machine 

4. Adding a Product Key for DSDK Application in the Remote Manager. 

5. Getting a License for DSDK Application from Activation Server 

6. Storing a License in a Target Machine 

<Deactivation/Uninstallation>: 
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1. Deactivate a License from machine 

2. Deactivate a License from Activation Server 

3. Uninstalling the DSDK Application from the Target Machine 

Case 1 

<Installation/Activation>: 

(1) If a work state archive is not saved during steps 1-4, it is not a problem. Input the 

information again. 

(2) If a work state archive is not saved between steps 5 and 6, you cannot perform step 6. As 

a result, the product key will be wasted until further action is taken. In this case, ask the 

administrator of the Activation Server to forcibly deactivate the license. 

(3) If a work state archive is not saved after step 6, reregister the machine with Remote 

Manager. However, the following problems may happen: 

 If the machine gets damaged, replaced, or discarded, it becomes extremely difficult to 

identify the machine in question. 

 Volume license information (remaining number of license number activations) cannot be 

obtained. 

 Deactivation Step 2 will not be doable without identifying the “Product key” used in 

activation step 5 to obtain the license. 

<Deactivation/Uninstallation>: 

(1) If a work state archive is not saved between steps 1 and 2, you cannot perform step 2.  

As a result, the product key will be wasted until further action is taken. In this case, ask the 

administrator of the Activation Server to forcibly deactivate the license. 

(2) If a work state archive is not saved between steps 2 and 3, reregister the machine with 

Remote Manager and use "refresh" from the View menu. Then, select the installed DSDK 

application and uninstall it from the target machine. 

Case 2: If an IP address has changed between steps 5 and 6. 

If a work state archive was saved, it is possible to update the IP address shown under the 

“MFD Address” column in the Device List (csv file), and then import the Device List into 

Remote Manager. 

Case 3: If an IP address has changed after step 6. 

Reregister the machine using the new IP address with Remote Manager, and proceed 

normally to deactivation step 1. To finish deactivation step 2, the “Product Key” must be 

entered again to complete deactivation with Remote Manager. 
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Case 4: If an IP address has changed between deactivation steps 1 and 2. 

If a work state archive was saved, open the work state archive and select "Deactivate" from 

the Operations menu.  Then, step 2 (Deactivating a license from Activation server) can be 

completed even if the IP address has been changed. 

Case 5: If an IP address has changed between deactivation step 2 and uninstallation 

step 3. 

Reregister the machine using the new IP address with Remote Manager, and proceed to 

uninstallation step 3. 

Collection of Remote Manager's Logs  

If a problem occurs in Remote Manager, collect the following logs that are saved in the 

folder (default folder name: temp) where “EmbeddedSoftwareRemoteManager.exe” file is 

located so that they may be used for analysis: 

 EmbeddedSoftwareRemoteManager.exe.log 

 InstallApple.exe.log 

 UninstallApple.exe.log 

Log collection settings can be changed by editing the ClientActivator.ini file located in the 

Remote Manager folder. The relevant section of the ClientActivator.ini file has been copied 

below for your reference: 

[Log] 

Dir=.¥temp 

Remove=0 

;Note: 

;By default, log files collected by Remote Manager are saved. 

;The log is stored in one of three files: a general 

EmbeddedSoftwareRemoteManager.exe.log, 

;and separate logs containing details for Installation and Uninstallation operations. 

;Each time Remote Manager is run, new information is appended to these logs. 

;As a result, it is recommended that the files be moved, edited, or deleted periodically to  

;reduce the size and increase the readability of the logs. 

;If a ";" is added before Remove=0, the log file will be deleted when Remote Manager is 

closed.  

;The above settings will store logs in a folder called "Temp". 

;The folder is automatically created by Remote Manager  

;according to the path set by Dir=.¥temp.    
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VM Card Installation and Uninstallation 

Installation Procedure 

 

 The VM Card should be kept in the machine. The card is only removed after 

uninstalling the DSDK application. 

 The VM Card should NEVER be removed from the machine while the machine is 

turned on or while power is being supplied to the machine via the main power 

switch. Doing so can damage the VM Card, and this may result in damage to the 

machine, requiring a technician. 

 The SDK/J Platform should be kept in the SD Card and NEVER copied to the hard 

disk drive (HDD). Copying to the HDD can result in damage to the SD Card or 

machine. 

 There is one JAVATM Platform, which auto-installs from the SD Card. 

 If no slot is available, move the Printer/Scanner application to the PostScript SD 

Card. 

 The SDK/J Platform cannot be moved to any other SD Card. If the SDK/J Platform 

is moved to any other SD Card, the SDK/J Platform can be damaged. 

1. Turn off the operation switch, and then off the main power switch if the machine is 

turned on. 

2. Insert the SDK/J Platform Type C SD Card into an available slot on the machine.  

 

 See "Important" at the beginning of this section. 

3. Turn on the machine. 

4. The SDK/J Platform auto-installs on the machine. 

Confirm that the SDK/J Platform has been successfully installed, as follows: 
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5. Press User Tools/Counter key on the machine's operation panel. 

6. The screen shown above is displayed. 

7. Press "Extended Features Settings". 

 

8. The screen shown above is displayed. 

9. Press "Extended Features Settings". 

 

10. JavaTM Platform field appears. 

 

11. Press "Extended Feature Info" tab to confirm settings. 

12. Press "Extended Feature Name" line. 
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13. Confirm that the JavaTM Platform settings are correct. 

14. Press "Exit" to return to the previous screen. 

15. If you would like to change the function key allocation, go to the next step. Otherwise, 

press "Exit" several times to go back to the main screen. 

 

16. Press "Change Allocation" tab. 

17. Press "JavaTM Platform" line. 

 

 The Other Functions key is allocated by default. Select whichever key you like 

to access the Java Platform. 
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18. Press a function key to allocate a key (e.g., Copy, Printer or Scanner), and then press 

"OK". 

 

19. Press "Exit" twice to exit out of "Extended Feature Settings" and "User Tools. 

Uninstallation Procedure 

 

 When uninstalling the SDK/J Platform, first uninstall the DSDK application(s) and 

Configuration Utility firmware from the machine. After the firmware is uninstalled, 

the SDK/J Platform can then be uninstalled. 

 Do not remove the VM Card before the SDK/J Platform is safely uninstalled. 

Otherwise, the SDK/J Platform may be damaged and also the machine may be 

damaged. 

 The VM Card should NEVER be removed from the machine while the machine is 

turned on or while power is being supplied to the machine via the main power 

switch. Doing so will damage the VM Card; this may result in damage to the MFD, 

requiring a technician visit. 

1. Press "User Tools/Counter" key on the operation panel of the machine. 
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2. Press "Extended Feature Settings". 

 

3. Press "Extended Features Settings". 

 

4. Press "Uninstall" Tab. 

5. Press "JavaTM Platform" line. 



Appendix 

76 

 

6. Selection screen is displayed on the LCD. 

7. Press "Yes" to uninstall. 

 

8. Confirmation screen is displayed on the LCD. 

9. Press "Yes" to proceed the uninstallation procedure. 

 

10. Completion screen is displayed on the LCD. 
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11. Press "Yes" to terminate the uninstallation. 

 

12. Press "Exit" twice to get out of Extended Features and User Tools. 

 

13. Turn off the operation switch of the machine.  

14. Wait until the green LED stops blinking, and then turn off the main power switch. 

15. Wait 30 seconds and remove the VM Card. 

 

 Turn on the machine before installing a new SDK/J Platform. 

Procedure for Changing a Device's Heap and Stack Sizes 

Step 1: From Administrator Tools ➔ Heap / Stack Size Settings 
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Step 2: Edit Heap and Stack size settings using the “Change” or “Restore Defaults” buttons. 

 

07A and 08S models: Default Heap Size 10MB, Default Stack Size 64MB. 

05A models: Default Heap Size 8 MB, Default Stack Size 64MB. 
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